lllinois State Board of Educatio

ISBE 2006 Assessment Correc

All Schools Meeting May, 2006



Agenda

= |ISBE SIS Project Team

= Correction of Assessment Student Information Process

= Important Facts About Correcting Assessment Student Information
= |ISBE SIS Key Assessment Student Information Correction Dates
= Assessment Correction Data Elements

= Expected Result Codes

= File Format Requirements

= Steps for Correcting Assessment Data

= Assessment Correction Reports

= Districts Next Steps

= Where Do | Direct My Questions?

= Questions & Answers

2 | | May, 2006




ISBE SIS Project Team

* |ISBE Key Team Members
- Connie Wise
- Terry Chamberlain
- Becky McCabe

= |IBM Key Team Members
- Howard Hammel
- Jaimie McQuirt
- Annette Boxman
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Correction of Assessment Information Process

= |SBE to provide Districts with student Assessment Data captured on
the last day of testing period.

- Assessment Correction File distributed via IWAS/SIS to Superintendents to
make corrections for re-submittal to ISBE/SIS.

= The file will be provided in a comma separated values (.csv) format

- On-line Reports available via IWAS/SIS for view-only review of Assessment
data.

= The Assessment Correction data will not reflect updates to student
demographics that occurred after the end of a District’s testing window.

= |nitial Assessment Correction File will provide Result Codes and
Result Messages for each student identifying discrepancies.

- Examples: F — No Pre-ID record on file, Grade levels do not match
P3 — Accepted Update Post Assessment Correction
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Correction of Assessment Information Process

= The Assessment Correction file will contain an Action
Code for each student record.

- The action code in the initial file will default to ‘U’ — Update for each
record.

- When a record is Added or marked as Inactivated, the District must
modify the Action code from update (U) to inactivate (I) or add (A).

- If arecord is marked as ‘I’ (inactivate) a Reason for Exemption must
be provided or that record will fail and the student record will not be
inactivated.

= Districts are to review their Assessment Correction file and
make revisions to the data to reflect detalls as of the last
day of their assessment test period.
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Correction of Assessment Information Process, cont.

= Corrections may be submitted using the Excel 2006 Assessment
Correction Template (converted to .csv for uploading via IWAS/SIS) or
as a comma delimited .txt file.

- XML formatted Assessment Correction files will not be accepted.

- All corrections must conform to the order and definition of data elements as
stated in the SIS File Format layout and Data Element documents.

= School/District to upload their Assessment Correction (.csv or .txt) file
with their changes via IWAS/SIS.

- Existing SIS Upload and Download functions will be utilized.

- SIS will process the changes, update the 2006 Assessment Data and return
the file to districts with result codes and messages.
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Correction of Assessment Information Process, cont.

= The SIS generated Assessment Correction file will be
provided one time during the initial download period.

- Districts will not be able to request a new file be generated from SIS
after updated Assessment Correction files are submitted.

- If a District wishes to verify Assessment information is updated and
accurate in SIS Districts should:

= Confirm that the Result Codes on the processed files do not contain
errors (No F or | Result Codes)

= Utilize the View-only Assessment Correction Reports on SIS to verify
information after revisions are submitted and accepted.

= |SBE will send a final Assessment file to Assessment
vendors.
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Important Facts About Correcting Assessment Data

= Corrections to student assessment data must reflect their
demographic, enroliment and assessment details as of the last day of
the district's assessment testing period.

= Corrections to student assessment data will revise only the captured
data being submitted to the assessment vendors; it does not correct
student details in SIS.

- Updates to SIS student demographic, enrollment, program indicators, and
enrollment exits are to continue through the end of the current school year.

- If student demographic errors are identified in the Assessment Correction
file, revisions must be made to both the Assessment Correction file as well
as in SIS via the Student Demographic/Enroliment file (if not already
updated in SIS).
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ISBE SIS Key Assessment Correction Dates

Activity Dates

Assessment Correction File available for
Downloading by Districts

Grades 3-8 (Test ISAT, IMAGE & IAA) COMPLETED
Grade 11 (Test PSAE & IMAGE & I1AA) May 13, 2006

Assessment Reports available for view
Grades 3-8 (Test ISAT, IMAGE & IAA) COMPLETED
Grade 11 (Test PSAE & IMAGE & |IAA) May 13, 2006

First day to upload revisions to Assessment
Correction file data via IWAS/SIS

Grades 3-8 (Test ISAT, IMAGE & IAA) COMPLETED
Grade 11 (Test PSAE & IMAGE & IAA) May 13, 2006
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ISBE SIS Key Assessment Correction Dates, Cont’d.

Activity Dates

Last Day to send revisions to Assessment
Correction file data via IWAS/SIS

Grades 3-8 (Test ISAT, IMAGE & I1AA) COMPLETED
Grade 11 (Test PSAE & IMAGE & 1AA) May 26, 2006

2006 Assessment Post Testing file sent by ISBE
to Test Vendors

Grades 3-8 (Test ISAT, IMAGE & I1AA) COMPLETED
Grade 11 (Test PSAE & IMAGE & 1AA) May 31, 2006
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ISBE SIS Key Assessment Correction Dates, Cont’d.

Activity
Posting of Student and Test Information on
Testing Vendor’s site

Grades 3-8 (Test ISAT, IMAGE & I1AA)

Grade 11 (Test PSAE & IMAGE & IAA)

2006 Assessment Post Scoring file sent via
IWAS/SIS for Districts to correct student
assessment data

Grades 3-8 (Test ISAT, IMAGE & IAA)
Grade 11 (Test PSAE & IMAGE & I1AA)
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June 1, 2006
July 3, 2006

June 5, 2006
July 10, 2006



ISBE SIS Key Assessment Correction Dates, Cont’d.

Activity Dates

Post Scoring Assessment Reports available for

view
Grades 3-8 (Test ISAT, IMAGE & IAA) June 5, 2006
Grade 11 (Test PSAE & IMAGE & IAA) July 10, 2006

First day to upload revisions to Post Scoring
Assessment Correction file data via IWAS/SIS

Grades 3-8 (Test ISAT, IMAGE & I1AA) June 5, 2006
Grade 11 (Test PSAE & IMAGE & IAA) July 10, 2006
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ISBE SIS Key Assessment Correction Dates, Cont’d.

Activity Dates

Last Day to send revisions to Post Scoring
Assessment Correction file data via IWAS/SIS

Grades 3-8 (Test ISAT, IMAGE & IAA) June 30, 2006
Grade 11 (Test PSAE & IMAGE & I1AA) July 28, 2006

2006 Assessment Post Scoring file sent by ISBE
to Test Vendors

Grades 3-8 (Test ISAT, IMAGE & IAA) July 1, 2006
Grade 11 (Test PSAE & IMAGE & IAA) July 31, 2006
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Assessment Correction Data Elements

Data Elements Mandatory/Optional

1 | Add, Inactivate or Update Mandatory

2 | Reason for not Testing Mandatory if action ‘I’
3 | Student Id Mandatory

4 | SAP ID Optional

5 | Legal Last Name Mandatory

6 | Legal First Name Mandatory

7 | Legal Middle Name Optional

8 | Birth Date Mandatory

9 | Race Mandatory

10 | Gender Mandatory

11 | Homeless Indicator Mandatory
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Assessment Correction Data Elements, cont.

Data Elements

Mandatory/Optional

12 | Migrant Indicator Mandatory
13 | LEP Indicator Mandatory
14 | IEP Indicator Mandatory
15 | FRL/Low Income Indicator Mandatory
16 | Century 21 Indicator Mandatory
17 | RCDTS for Home School (Student Demo) Mandatory
18 | Entry/Grade Level (Student Demo) Mandatory
19 | RCDTS for Home School (Pre-ID) Mandatory
20 | RCDTS for Serving School (Pre-1D) Mandatory
21 | Valid Grade at Time of Testing (Pre-ID) Mandatory
22 | First Year in U.S. (Pre-ID) Mandatory
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Assessment Correction Data Elements, cont.

Data Elements Mandatory/Optional

23 | Year in Any lllinois-Approved TBE/TPI Mandatory
Program (excluding Pre-K and K) (Pre-ID)

24 | Year Since Exited TBE/TPI Program (Pre- Mandatory
ID)

25 | Enrolled in Home School On or Before May Mandatory
1 (Pre-ID)

26 | Enrolled in Home District On or Before May Mandatory
1 (Pre-ID)

27 | Test To Be Taken Mandatory

28 | Placeholder 1 N/A

29 | Placeholder 2 N/A

30 | Placeholder 3 N/A
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Assessment Correction Data Elements, cont.

Data Elements Mandatory/Optional
31 | Placeholder 4 N/A
32 | Placeholder 5 N/A
33 | Placeholder 6 N/A
34 | Placeholder 7 N/A
35 | Result Code N/A
36 | Result Message N/A

= The ISBE SIS Export file is returned in the same format with the same data
that was provided plus the following for each record:

Result Code, and
Result Message.
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State Assessment Non-Participation Reason Codes

Code Value

01 Medically Exempt

02 Homebound Exempt

03 In Jail/Locked Facility

04 Out of State/Country

05 Not Enrolled

06 Not In Valid Grade

07 Transferred Out During Testing

08 Transferred In During Testing

09 Deceased
10 Absent
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Expected Result Codes

=‘P3’ — Accepted Update Post Assessment Correction
= ‘P4’ — Record Added Post Assessment Correction
= ‘P5’ — Record Inactivated Post Assessment Correction

=‘]" ~ SID does not exist or SID and First Name, Last Name,
or DOB do not match existing record

= ‘F’ — Missing or Invalid Data

Note: The Result Code and Result Message will be appended to the
end of the record.
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File Format Requirements

* File Formats Supported

- Excel Spreadsheet converted into a Comma-separated Value, CSV
format

= Note: An Assessment Correction Excel template and tip sheet
are available on the SIS website — www.isbe.net/sis

- Text (Comma Delimited)
= File must contain a Header Row

* File must conform to the ISBE SIS File Format Layouts
dated 04/10/2006
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Steps for Correcting Assessment Data

1. Superintendent must download the Assessment Correction .csv file from
IWAS/SIS/Download File screen.
- Superintendent must login to IWAS
- Access SIS from System Listing
- Click Download File link within SIS
- Locate the Assessment Correction File named — AssesCorrFromISBE_RCDTS.csv
= Example: AssesCorrFromISBE_010010010260000.csv

- Save the file to a local computer or server
= NOTE: DO NOT OPEN THE FILE AND THEN SAVE WHILE THE FILE IS OPEN. Save the
file before opening in Excel. For example, right Click and perform ‘Save As’ or ‘Save Target
As'.
2. If necessary, Superintendent must provide the Assessment Correction .csv
file to additional support staff.

21 | | May, 2006




Steps for Correcting Assessment Data

3. Download the Assessment Correction Excel Template, Tips Sheet, and
Steps for Correcting Assessment Data
- Located on the SIS Website — www.isbe.net/sis
- Under Hot Links - Excel Templates
- Excel Template is named - 2006 Assessment Correction

- Excel Tips is named - Tips for Completing ISBE 2006 Assessment Correction
Template

- Steps document is named - Steps for Correcting 2006 Assessment Data

- Save the files to a local computer or server

= NOTE: DO NOT OPEN THE FILE AND THEN SAVE WHILE THE FILE IS OPEN. Save the
file before opening in Excel. For example, right Click and perform ‘Save As’ or ‘Save Target
As'.
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Steps for Correcting Assessment Data

4. Appropriate personnel must import the data to the Assessment Correction

excel template

- Open the CSV Assessment Correction file (AssesCorrfromISBE_RCDTS.csv) in
excel (DO NOT SAVE IT)

- Open the Assessment Corrections excel template

- Keep both the source data spreadsheet and the template open

- Highlight the cells - Row 2/Column A through Column AJ and all rows with student
data

= Note: Make sure the Result Codes and Result Messages (Al and AJ) are copied to the
template

= Do not highlight beyond column AJ or highlight the entire row
- Select Edit > Copy
- Navigate to the Assessment Corrections Excel Template
- Click on cell Row 3/Column A prior to pasting the data
- Select Edit > Paste Special
- When the pop-up box opens Select Values and click Ok.
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Steps for Correcting Assessment Data

5. Review the Assessment Data relocated to the Assessment Correction excel
template

6. Make Changes
- All corrections are made in the Assessment Correction excel template

- Do not make any changes to information in the CSV format as the formatting will be
lost and errors may result when submitted.

- Correct all errors identified by an ‘F’ or ‘I' in Column Al

- Change inaccurate data such as program indicators, grade levels, gender codes
etc.

- Actions to update (U), inactivate (I) or add (A) a record must be entered in Column
A for each record.

- When arecord is marked as ‘I’ (inactivate), Column B - Reason for Exemption must
have an entry or the action to that record will fail.

- Note: Do not add students to this file for other grade levels
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Steps for Correcting Assessment Data

7. Create the Assessment Correction .csv File Header in Row 1/Columns B, C,
D&E
- Row 1/Column B is the number of student records being submitted
- Row 1/Column C is the File Name (NOTE: This name is used to create the .csv file)
- Row 1/Column D is the date the file is being submitted to IWAS/SIS
=  Example: 05/15/2006

- Row 1/Column E is the 15 digit District/School’'s RCDTS code

= Note: This is the RCDTS assigned to your IWAS account. This can be verified via your
IWAS profile.
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Steps for Correcting Assessment Data

8. Save the Assessment Correction Excel Template as a .csv file

Open the Assessment Corrections Excel Template or if you already have the
spreadsheet open save the Excel version (.XLS extension).

On the File menu click File > Save As.
In the File Name box type the same file name as you typed in 1-C excluding the

.CSV”.
In the Save As Type list, select CSV (Comma delimited) to add the .csv extension.
Click Save.

When notified that the file may contain features not compatible with CSV click Yes
to keep the workbook in the current format and finish saving the file.

Close the Excel file.
= When prompted to save your changes to the CSV file click No.

Note: There will be 2 files at the end of these actions: the excel template and a .csv file
9. Upload the .csv file via IWAS/SIS/File Upload screen
10. After the file is processed, Download the file and review Result Codes and

26
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Assessment Correction Reports

= Link to the Reports

SIS HOME | [5EE HOME | LOSOFF
Illinois State
' Board of Education

Student Information System
lllinois State Board of Education (ISBE) Student Information System (SIS - EEE

ISBE The available facilities of ISBE 818 are listed below :

Home

Search SID « Search for a student
Request Mew SID e Request for a student ID
Exit Enrollment + Exit Enrollment

pload File + File uploading

Download File + File downloading

Reports s Assessment

Help e Help

Test Site

Have questions or need help? Contact our Call Center (217)558-2600 between 8:00am - S:00pm CST, Monday - Friday or Click here to Contact Us
Copyright & 2006, Ilinois State Board of Education
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Assessment Correction Reports

= Links to the Assessment Correction Reports

5[5 HOME | [5EE HOME | LOKSOFF

“ Tllinois State

) Board oE R amsition Student Information System

View Report TiEour 19159

ISBE Assessment
Horne
Search SID « 2006 Assessment Correction Report {Detail)

Request Mew SID + 2006 Assessment Discrepancy Report {Summary)
Exit Enrollment

Upload File

Cownload File

Feports

Help

Test Site

Hawe questions or need help? Contact our Call Center (217)558-2600 between 2:00am - 5:00pm CST, Monday - Friday or Click here to Contact Us
Copyright @ 2006, Illinois State Board of Education
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Assessment Correction Reports, cont’d.

= Search Criteria for the Assessment Correction Report (Detail)

29

[SEE HOME | LOGOFF

2006 Assessment Correction Report S 1545

Select criteria provided below

Assessment Reporting School: |au_
Valid Grade at Time of Testing: |ALL [+]
Race: |ALJ_ M
Gender: © Both ¢ Male C Female

Migrant Indicator: & Both © Yes © No

LEP Indicator:  Both  Yes  No

IEP Indicator: @ Both  Yes  No

FRL/Low Income Indicator: @ Both  Yes © No

Century 21 Indicator: * Both  Yes { No

Enr. in Home Sch. (o/bMay 1): < goth  Yes  No

Enr. in Home Dist. (o/b May 1): # Both  ves { No
Status Code: ( Both " A-Active ( I-Inactive

Soray e —

Have questions or need help? Contact our Call Center (217)558-3600 between 8:00am - 5:00pm CST, Monday - Friday or Click here to Contact Us
' Copyright @ 2006, Illinois State Board of Education
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Assessment Correction Reports, cont’d.

= View the Assessment Correction Report (Detail)

00 OO01:Q0 [ O (o

2006 Assessment Correction Report (Detail) 122008
Assessment Home District: 010010010260000 PAYSON CUSD 1
Selection Criteria:  Assessment Schgol = ALL, Grade At Time of Testing — ALL, Race = ALL, Gender = Female, Migrant = Both, LEP = Both, [EP = Both, IEP = Both, FRL = Both,
Century 21 = ome School = Both, Home District =

135792468 Conn|eW|se 03 N N|N|N|Y | N|0M0| 0B 07|03 | N | N |ISBAT

SIS Home School: 010010010260000 AmimthnmSchml 010010010260001 4Senm_mmummom I
579024681 Becky McCabe s F| N | N|N|N|[N|N|og8|o8|N[07 03| N|N[sAT [A]3
SIS Home School: 010010010260000 Aszzezement Home School: 010010010260001 Assessment Serving School: 010010010260001
346791023 Jaimie McQuirt o | FIN[N[N|N|Y [N oa[oa [N 07[03 N[N [SAT |a(3
SIS Home School: 010010010262002 Assessment Home School: 010010010260001 Assessment Serving School: 010010010262002
867530928 Mary Brown [os[ Fl | N[N ¥ [¥ | w|os|os| N [o7|o03|N|[w[mar [als
SIS Home School: 010010010260000 Assessment Home School:010010010260001 Assessment Serving School: 010010010260001
734086501  Annette Boxman |05|F|N|N|N|N|Y|N|°4|04|N|0?|03|Y|Y|ISAT A
SIS Home School: 010010010262002 Assesement Home School: 010010010262002 Assessment Serving School: 010010010262002
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Assessment Correction Reports, cont’d.

= Search Criteria for the Assessment Discrepancy Report (Summary)

[SEE HOME | LO@OFF

Board GfEd.xic'atian 2006 Discrepancy Report Summary s

Select criteria provided below

Assessment Reporting School: |aLL =]

[ Create Report | | Refresh Screen |

Ha\v‘é quastrgnsw ﬂerad heip? Ewritaﬁtuur Ga]l Center CEH.?}SSEP‘B@BB bfﬁtvétéaﬁ 8:00am - 31 DD}:in‘r CST, s Mﬁnday Fﬁdag or Gfl:k L'sem tﬂ f:uﬁtarﬁ Us
Ctm?’ﬁ;ht © 20086, Ilinois State Board of Education
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Assessment Correction Reports, cont’d.

= View the Assessment Discrepancy Report (Summary)

School: 01-001-0010-26-2002 PAYSON CUSD 1 SEYMOUR ELEMENTARY SCHOOL
School Grade Served: 123456
DISCREPANCY CHECK AND SUMMARY TABLE
Discrepancy Check of Data From County-District-School, 515 Enroliment, and S15 Assessment Pre-10 Lab
Assessment CDS File 8IS 818
Tested Grade Served Enrollment PredD File Discrepancy
k] X H H
L) X 47 47
5 X 4 4
[ X a3 a3
7 0 0
H] 0 0
1 0 0

Summary for the Student Demographicifssessment Pre-1D File

State Assessment Tested Grade
Categories
Grade 3 Grade 4 Grade 5 Grade 6 Grade ¥ Grade § Grade 11
Total H 17 H 53 0 1] I}
Female [01] [ i | 18 A 0 0 0
Hale [02] 13 2 23 A 0 0 1]
American Indian! Alashan Native (01 0 0 0 0 1] 1] I}
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Assessment Correction Reports, cont’d.

= View the Assessment Discrepancy Report (Summary), cont’d.

Asiant Pacific Islander [02) 1] 1] 1] 0 0 0 1]
Black! African American (03) 1] 1 1] i 0 0 1]
Hispanic [04) 1] 1] 1] 0 0 0 0
White [015) u 46 4 2 0 0 0
Multiracial! Ethnic [05) 0 0 0 0 ] 0 0
Higrant

Yez [01) 0 0 0 1] 0 0 0

Mo (02 k- | 47 4 52 ] 0 0
LEP

ez [M] 0 0 0 0 0 0 0

Ma [02) H LY 4 23 0 0 0
IEP

Yez [01) g ) 10 g 0 0 0

M (02 26 40 H 15 ] 0 0
Freefeduced Price Lunch

Yez (1] 19 19 A 16 0 0 0

Mo (02) 15 » M ki) ] 0 0
21th Century

ez [01) 0 0 0 ] ] 0 0

Ma (02 H 47 4 3l 0 0 0
Homeless

ez (0] 1] 1] 1} ] 0 1]

Mo (02 H 47 4 it 1 0 0
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Assessment Correction Reports, cont’d.

= Print the Assessment Correction Reports

‘ @%004‘){1100 o Qw7 ersta ‘

Print the report

Enter the page range that you would like to Print.
O Al

* Pages

From:|1 |T0:|1

To Print:
1. In the next dialog that appears. select the "Open this file" option and click the OK button.
2. Click the printer icon on the Acrobat Reader Menu rather than the print button on your internet browser.
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Districts Next Steps

= Download the Assessment Correction file.
= Import data into the Assessment Correction Template.

= Make corrections, if needed, to the Assessment Correction data for
submission to ISBE SIS.

= Upload your revised Assessment Correction file (.csv or .txt) via
ISBE/IWAS/SIS — File Upload functionality.
- Do NOT send files via email to ISBE agency — upload via IWAS/SIS.

= Review each file’s result codes and messages once it has been processed
and returned to you (SIS — Download file screen).

= Correct any errors and resubmit the file to ensure assessment data are
accurate.
= Review corrected Assessment Data via
- Downloaded Assessment Correction File
- Assessment Correction Reports
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Where Do | Direct My Questions?

= |ISBE Help Desk
- (217) 558-3600
- help@isbe.net

- Assessment Policy Questions will be directed to the Assessment
Division

- SIS Assessment Correction File Technical Questions will be
directed to the IBM team
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Questions & Answers

Discussion / Questions
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ISBE Contact Information

Connie Wise
217.782.3950
cwise@isbe.net

Terry Chamberlain
217.782.4313
tchamber@isbe.net

Becky McCabe

217-782-4823
rmccabe@isbe.net
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